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July 10, 2010 was busy.  Many of our 

club members had several commit-

ments that day.  The 35 or so that at-

tended the LCACE picnic were re-

warded with a pleasant after-

noon.  Mike McEnery and Julio Rivera circulated 

with their cameras to record the event. 

 

The weather was great - Jack Frost even made an 

appearance!  Our host/chef, Fred Barnett, per-

formed like a pro.  Our hostess, Liz Barnett, warmly 

welcomed everyone and organized the huge buffet 

we created.  Liz also cooked and baked for us.  In 

addition to all of this, Fred and Liz had preparation 

and clean up duty.  They did a wonderful job. 

 

The club provided hot dogs, hamburgers, rolls, con-

diments, utensils and soda.  Those that were curi-

ous about the gallons of yellow liquid we drank will 

be happy to know it was Crystal Lite Lemon-

ade.  Again, we proved that LCACE has some great 

cooks! 

Betsy Alleman won the 50/50 raffle. 

Winnie Frost passed out our Holiday Party raffle tickets 

to those that could hardly wait to get their hands on 

them. 

 

Some members discovered the complexities of getting to 

the Alleghany Road address, when they were on the 

south side of Route 120. 

 

The Barnett's back yard has a pretty steep hill.  Jay Bit-

terman proved what a well balanced person he is.  He 

put his chair legs on two round sticks, trying to level the 

ground and it worked! 

 

Lester Larkin, on the other hand, provided live entertain-

ment with his acrobatic act.  He flipped over back-

wards.  He and his chair rolled down the hill.  (He re-

fused to re-create this event for Julio's camera.)  And, 

yes, it's true - Lester does eat something other than fish 

sandwiches! 

 

Thank you, Liz and Fred for so graciously sharing your 

home with us.  Your hospitality was very much appreci-

ated. 

Donna Lee Kalinoski 

July Barbeque 

Microsoft Offers Free 

Online Version of Office 

by Ira Wilsker  

WEBSITE:  http://www.live.com 
(Click on "Office")  

     In the over 10 years I have been 
writing this weekly column I have 
used the Microsoft Word installed 
on my desktop computer for all but 
a handful of the columns. There 
were a few columns I wrote while 
using Open Office as a topic of the 

column; one column was typed using 
Google Docs and saved as a Word 
file to send to my editor.  Today I am 
using Microsoft's recently released 
Word Web App, which is one of the 
several Office utilities now available 
for free at www.live.com.   Since 
these applications are online, they 
can be accessed from anywhere the 
user has internet access, and are 
utilized in a browser win-
dow.      From the live.com webpage, 
the office applications can be utilized 
by clicking on the "Office" link at the 
top of the page.  Word, Excel, 

(Continued on page 7) 
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Membership 

 

Membership in LCACE is open to all individuals and 

families interested in personal computing. Annual dues 

are $20.00 per individual/family. Associate 

membership is only $10.00 (out of state, unable to 

attend meetings). Membership includes a one year 

subscription to the LCACE News Journal and access 

to all club libraries and functions. Applications for 

membership may be obtained at the monthly meeting, 

by request on the club hotline, and are now available 

on our web site at  - http://www.lcace.org. 

 

Meetings 

LCACE meetings are usually held on Saturdays at the 

Grayslake Area Public Library, 100 Library Lane, 

Grayslake, Illinois. The meeting room opens at noon 

and  the formal meeting begins at 12:30 p.m.  All 

meetings are open to the public.  Bring a friend! 
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club address by the 21st of the month preceding 

publication. For more information on ad pricing, please 

call our Hotline. Ads are FREE to all paid members. 

 

 Notice 

LCACE WILL NOT CONDONE  or knowingly 

participate in copyright infringement of  any kind. The 

LCACE News Journal is published by and for LCACE 

members. Opinions expressed herein are those of the 
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Robin’s  

RAMblings 
 

I hope everyone is having a wonderful summer!  Wendy 

Warden demonstrated the use of digital nature photogra-

phy at our June meeting.  Despite technical glitches, we 

all learned a great deal from Wendy’s spirited presenta-

tion.  Lester Larkin and Henry Henriksen took home port-

able office kits, our door prizes donated by the Grayslake 

Area Public Library. 

 Two new members joined at the June meeting:  

Carolyn Lewis and Harriet Rudnit.  Carolyn is a camera 

enthusiast who would like to learn more about what to do 

with her photographs when she puts them on her com-

puter.  Harriet is a retired teacher and a Mac owner who 

uses some Windows applications.  Carolyn and Harriet, 

welcome to LCACE! 

 Everyone, if you haven’t already done so, it’s time 

to pay your LCACE dues.   

 We owe a huge thank you to Liz and Fred Barnett 

for graciously offering to host the club picnic on July 10th; 

it was a rousing success.  

 We have great programs scheduled for 2010 and 

2011: 

August 14-Best Buy of Mundelein will present the latest 

in technology 

September 11-Show and Tell and Ask the Gurus 

October 9-Virtual machines presented by Julio Rivera 

and Fred Barnett 

November 6-Robin Seidenberg will present ―My Uncle, 

the Hollywood Producer‖ which the Grayslake Area Pub-

lic Library will co-sponsor 

December 4-Holiday party-State Bank of the Lakes-1-5 

p.m. Save the date! 

January 8, 2011-Show and tell and ask the gurus 

 

We have very exciting news.  This year we will have five 

holiday raffle prizes: 

1st prize-HP 17" Notebook with Intel Core 2 Duo T6600 

Processor, 4GB of RAM, 320GB hard drive, webcam and 

microphone, LightScribe SuperMulti 8X DVD±R/RW with 

Double Layer Support, 5-in-1 integrated digital media 

reader, and Windows 7. 

 

2nd prize-Acer Aspire One 10.1” Netbook with Intel 

Atom N450 processor, 1GB of RAM, 160GB hard drive, 

and Windows 7 Starter. 

 

3rd prize-Apple iPod Touch-8GB 

 

4
th

 prize-VuPoint Magic Wand Scanner 

 

5th prize-One year LCACE membership 

 

 Tickets are $1 each; 6 for $5, and 25 for $20.  

The more tickets you buy, the better your chances of 

winning one of these fabulous prizes.  Winners do not 

need to be present so plan to sell tickets to out of town 

family and friends.   

 Raffle tickets will be available for sale at our Au-

gust meeting.  In addition to buying tickets for yourself, 

please plan to pick up tickets to sell.  The person who 

sells the winning first prize ticket and also the person 

who sells the most tickets will receive a prize at the holi-

day party. 

Happy computing! 

DigitalCorner 
Four Rules of Composition 

Thirds 
Rule of odds 
Rule of space 
Viewpoint 

Need to know more, ask your club’s photography Guru. 



“Members Helping Members” 
(Spend money) 

Submitted by Gypsy D. Katz 

EzGear AV Cable for iPod with USB 

Here’s another case of ―Members Helping 

Members.‖ While visiting Milwaukee Com-

puter Society last weekend, Rick 

(president) gave a presentation of his new 

iPod. In order to display the videos stored 

on his iPod, he used a cable he pur-

chased which allowed him to connect to 

the club projector. Upon returning home, I 

immediately ordered one for my iPod/iPad. 

 

The ezGear Video Cable for new iPod, iPhone and IPad 

allows me to play movies, music videos, TV shows, My 

Tube Clips, or Pictures stored on my iPod/iPad can now 

be displayed on any TV or my projector. The ezGear 

Video Cable is part of the made for iPod program and 

incorporates Apple's Dock Connector with the new Au-

thentication chip. The included a USB connector that al-

lows me to keep my iPod/iPad powered while I watch. 

The USB connector can also be connected to my com-

puter to sync my iPod or iPhone with iTunes. 

 

ioSafe Solo 1.5 TB Hard Drive 
ioSafe Solo is both fireproof and waterproof. 

 

This single hard drive has a capacity of  

1.5TB and is surrounded in metal that 

measures 11 x 7.1 x 5 inches that pro-

vides a protective layer around the 

drive. On the waterproof side it can be 

dunked for 3 days in up to 10 feet of 

water without causing damage to the 

drive inside. On the fireproof side of things the drive can 

withstand temperatures up to 1550 degrees Fahrenheit 

for up to 30 minutes. 

 

The ioSafe Solo weighs 15lbs making it rather heavy 

duty which is exactly what it wants to achieve. The bene-

fits of having a waterproof and fireproof drive is that you 

know your data will always be safe in the unfortunate 

event there is a fire or water issue. 

 

If you suffer a drive accident then you need to ship the 

burned out or dunked enclosure to ioSafe who will re-

cover the data that is kept completely safe on the drive 

within. When buying the drive you get access to 1 years 

of service which can be extended all the way to 5 years 

for a cost of $89. ioSafe also offer extra warranty on the 

drive as standard that allows for a $1000 service to re-

cover the data.  

 

In my opinion the ioSafe is great. It might lack a few con-

nectivity features, but it can be safely dunked in 10 feet 

of water for 3 days or subject to flames for 30 minutes at 

a temperature of 1550 degrees F, you are getting peace 

of mind. Of course such security doesn't come cheap. 

The 1.5TB model costs $199.99 through Costco. Yes, 

they are more expensive then standard external drives, 

but should you lose data due to fire or water incidents 

never lose a manual again  
by Linda Gonse, ORCOPUG 

I just found my old Sharp PDA, discovered it was still 

working, and decided to put it to use again. The down-

side was the manual was gone. An Internet search 

showed the original manual available, but prices ranged 

from $20 to $39! The Sharp device began to look obso-

lete to me. Then, I discovered retrevo.com. It boasts a 

library of more than 100,000 downloadable manuals from 

more than 1,000 brands of consumer electronics for con-

sumer electronics searchable by category and brand at 

http://www.retrevo.com/samples/index.html. My manual 

was there and it was free. In seconds, I downloaded it. 

There are more than 100 categories to search for manu-

als: 

There are more than 100 categories you can search 

for manuals: 

2-way Radio  Air Conditioner  Amp  Bin-

ocular  Blender  Boombox  

Bread Maker  CD Player  CRT TV Calculator 

 Camcorders  Car Amplifier  

Car Receiver  Car Video  Cell Phone Clock Radio 

 Coffee Maker  Controller 

(Continued on page 6) 



Lake County Area 

Computer Enthusiasts 

“Members Helping Members” 

1st Prize: 

 

HP 17" Notebook  

Core Duo T6600  processor 

4GB of RAM 

320GB hard drive 

2nd Prize: 

Acer Aspire One 10.1” Netbook  

Intel Atom N450 

1GB of RAM 

160GB hard drive 

Windows 7 starter 

5th Prize:  

1-Year’s Membership LCACE  

Tickets: $1 each, 6 for $5, or 25 for $20 
 

Drawing December 4, 2010 

WINNER NEED NOT BE PRESENT 

3rd Prize:  

Apple iPod Touch-8GB 

A great music and video player, pocket 

computer and thousands of other uses. 

 

4th Prize:  

VuPoint wand scanner 

Fast and convenient way to scan, archive & 

organize for your personal use. 



Time to clean out your closet. Bring it to the meeting and 

place it on the FOR SALE or FREEBIE tables. All items 

placed on the FOR SALE table MUST have your name and 

asking price attached to it. If you just want to get it out of 

your closet, then place it on the FREEBIE table and hope 

one of your club members has a better home for it. All items 

not sold or taken must be reclaimed by the end of the meet-

ing. 

Copier  DVD Drive  DVD Players DVR 

 Desktop  Digital Camera 

Digital Photo Frame  Dishwasher  Dreamcast 

Game Dryer  Fax Machine  Film Camera 

Food Processor  Freezer  GPS

 GPS Accessory  Game Boy

 Game Console 

Game Cube Game  Gaming Accessory 

 Graphics  & Publishing Grill Guitar 

 Headphone Headset   

Heating Cooling/ Air  Home Theater Hub 

 Karaoke System  Keyboard

 LCD TV  

Labeling System Laptop MP3 Acces-

sory  MP3 Player  Microwave Mini Audio 

System 

Monitor  Mouse Multifunction Printer 

 Music Keyboard  NIC

 Network Adapter 

Nintendo DS Lite  Oven PBX 

 PDA  PDA Accessory PS2 Game  

Plasma TV  Portable DVD Player Portable TV 

 Printer  Projection TV Projector   

(Continued from page 4) Radar Detector  Radio Range 

 Receiver  Refrigerator Remote Con-

trol  

Router  Satellite Radio Satellite Re-

ceiver  Scanner  Security Camera

 Speaker   

Speaker System Storage Subwoofer 

 Switch  TV Tablet  

Tape Deck  Telephone Telescope  Turntable 

 VCR Vacuum 

Voice Recorder  Washer Watch

 Wii Game  Wireless Router

 Xbox Game 

Another benefit of the site is that it also will store your 

manuals for you. Is that great or what?  
At retrevo.com again later I learned that over 4 million 

people visit the site every month to get help with decisions 

about the gadgets they buy. Retrevo is NOT a retailer and 

does not sell consumer electronics, but it uses artificial in-

telligence to analyze and visually summarize more than 50 

million real-time data points from across the web; and 

gives shoppers comprehensive, unbiased, up-to-date 

product information about what products to buy as well as 

when and where to buy them. 

George Becht 

Robin SEidenberg 

Leslie Salsburg 



PowerPoint, and OneNote are currently available.  Reg-
istration is required in order to use the Microsoft Live 
utilities, but registration is fast and free.   For those users 
who may need access to the primary components of Mi-
crosoft Office, but do not have it installed on their com-
puters, this service from Live is a viable alternative. 

      I started by using Live's Word Web App to type this 
column.  The "ribbon" or menu at the top of  the browser 
window is reminiscent of the one in Word 2007, but does 
not have quite as many choices as the full version of 
Word 2007 on my computer.  While all of the major func-
tions are available, many of the 
enhancements and "bells and 
whistles" are not available on 
the web version.   The top line 
menu choices are "File", 
"Home", "Insert", and 
"View".  Above the ribbon are 
small icons to save and 
undo.   Clicking on the "File" 
tab  gives the user choices to 
open, save, share, close, prop-
erties, feedback, and pri-
vacy.   As I am typing this, I am 
periodically saving the file in 
the default .docx (Word 2007) 
format to Microsoft's SkyDrive, 
which is Microsoft's server 
sometimes referred to as "in the cloud".  Once saved to 
the SkyDrive, I can access this file from anywhere. 

      The default tab on the Word Web App is "Home" 
which displays the simplified Word 2007 ribbon (menu) 
with the ubiquitous copy, paste, fonts, formatting, spell 
check, and another feature which is not in the computer 
based version of Word, "Open in Word".  This "Open in 
Word" will connect to the Word installed on the com-
puter, and open the document in the computer based 
Word, but only if a compatible browser is being used.  I 
am using Firefox as my browser as I type this, and click-
ing on the "Open in Word" icon on the ribbon displays a 
message that my browser is not compatible.  Another 
anomaly (browser incompatibility) occurred when I tried 
to copy some text by painting it, right clicking and going 
to "copy".  A window opened that said, "Your browser 
does not allow access to the clipboard.  Use the key-
board shortcuts for cut, copy, and paste instead."  Using 
the keyboard commands CTRL-C allowed me to copy 
the text I wanted, and CTRL-V allowed me to paste it 
where I wanted it.  This inability to work nicely with some 
browsers other than Microsoft's lowers my opinions of 
this product; while it is not a fatal defect, I do not like the 
idea of being compelled to use Internet Explorer in order 
to utilize all of the features of the Word Web App.  The 

(Continued from page 1) "Insert" tab on the ribbon allows the user to insert a ta-
ble, picture, clip art or links.   The "View" tab  offers the 
user the choice of an "Editing View" and a "Reading 
View".  One important item missing from the menu is a 
"Print" button; I could not find any easy way to print a 
document, other than using the browser print function. 

     While Word may be one of the most widely used ap-
plications, Excel and PowerPoint are also very widely 
used.  The online version of Excel can be accessed by 
clicking on the Excel icon on the Live - Office web 
page.   The Excel Web App  looks much like a simplified 
version of the full computer based version of Excel, and 
uses the same interface and commands.  By default, 

files are saved to the Sky-
Drive in the Excel 2007 .xlsx 
format.  The first thing I no-
ticed on the Excel Web App is 
that the formula bar (Fx) does 
not pull down to display the 
list of available formulae.   I 
also found that the auto-fill 
functions where dates and 
cells could be auto-filled by 
clicking on the corner of a cell 
and dragging does not work, 
at least when used in Fire-
fox.  The ribbon bar on the 
Excel Web App looks much 
like a simplified Excel 2007 
menu bar, but lacks some of 

the choices available on the computer installed ver-
sion.  As with the other Microsoft Web Apps, the spread-
sheet can be shared as desired.  Also as with the Word 
App, the icon "Open in Excel" will generate an error.  Ac-
cording to the online help, none of the Web Apps will 
open the computer's Office if using Firefox and Office 
2003 or Office 2007; Microsoft's recommended fix is to 
install Office 2010.  The online help also says that the 64
-bit version of Internet Explorer is not supported, and that 
browsers other than Internet Explorer and Firefox are not 
supported at all.  That means that it may be difficult or 
impossible for the many users of Chrome, Safari, Opera, 
and other browsers to utilize these otherwise useful Web 
Apps. 

      I do a lot of PowerPoint presentations, and I was es-
pecially interested to try the PowerPoint Web App.  As 
with the other apps, it saves in the Office 2007 formats, 
in this case .pptx.  The screen looks familiar, but much 
simplified from the full version of PowerPoint.   One item 
obviously missing from the ribbon (menu) is the "save" 
button; that is because the PowerPoint Web App auto-
matically saves the presentation.   Another feature that is 
missing is the ability to right click on an image or text box 
in a slide to add animations or special effects.  I easily 

(Continued on page 8) 



inserted an image into a slide, and was given a choice of 
eight picture styles or frames, but could not animate or 
otherwise add the special effects that I sometimes use in 
the full version.  Other than using some of the more so-
phisticated features of the full version of PowerPoint, the 
Web App version is adequate for simple PowerPoint 
presentations.  

      I will admit that I do not use Microsoft's OneNote, but 
it is available as a Web App.  Looking much like a Word 
document, with the addition of a calendar line, when 
shared, it also shows the other authors and page ver-
sions that were accessed and modified.   OneNote also 
allows for images, clipart, links, and tables to be inserted, 
which can provide a richer user experience.  Like Word, 
the ribbon (menu) in OneNote allows the user to imple-
ment traditional formatting and fonts as desired.    I could 
see where OneNote would be useful for taking notes and 
sharing content.  As with PowerPoint, there is no "save" 
button, as OneNote documents are automatically saved. 

      If the user desires to import a document or image on 
his computer in the appropriate Web App, the user would 
click on the SkyDrive link at the top of the Office page, 
and then "Add Files".  The user can then drag and drop 
files from his computer into the "Add Files" browser win-
dow, or files can be uploaded to SkyDrive by clicking on 
"Select documents from your computer".   Documents 
and other files stored on SkyDrive can be downloaded 
individually in native format, or all of the files can be 
downloaded together as a single ZIP file from Sky-
Drive.  I experimented with SkyDrive and the Web Apps 
and found that this may be a viable choice either as a 
primary or backup method of doing presentations or 
working on documents away from my home or office 
computer, providing there is good internet access.  Click-
ing on the SkyDrive "More" link allows the user to view a 
file's properties, or delete it from SkyDrive. 

     One of the strengths of using web applications like 
these is the ability to work together or collaborate on pro-
jects.  By clicking on FILE - SHARE others can be au-
thorized to  access the file.  The share choices can be 
controlled with a slider that ranges from "Just me" to 
"Some friends", "Friends", "My friends and their friends", 
and "Everyone (public)".  Specific people can be added 
to those eligible to share by name or by email address. 

     While not as feature rich as the full versions of Office, 
the free Web Apps versions at live.com do offer a viable 
alternative to those who do not have Office installed on 
their computers, or who need a portable version of those 
applications.  Many users will find these Web Apps quite 
useful. 

(Continued from page 7) Inserting a Non-Breaking Hyphen 

When Microsoft Word calculates line length and wraps 

text to the next line, it tries to wrap (or break) the line at a 

space or a hyphen—a dash. Sometimes, however, you 

may not want Word to break a line at a dash. For in-

stance, dashes are used in telephone numbers, and you 

might not want a line to break in the middle of a tele-

phone number. 

The answer is to use non-breaking hyphens instead of 

regular dashes when you don't want Word to break a line 

at the hyphen. To do this, hold down the CTRL and SHIFT 

keys as you type the dash (this is the same as typing 

CTRL and an underscore). Word will then not break the 

line at that point. 

You can also insert a non-breaking hyphen by following 

these steps: 

1. Choose Symbol from the Insert menu or, in 
Word 2007, display the Insert tab of the ribbon, 
click Symbol in the Symbols group, and finally 
click More Symbols. This displays the Insert 
Symbol dialog box. 

2. Click on the Special Characters tab. 

 

The Special Characters tab of the Symbol dialog box. 

3. Highlight the Nonbreaking Hyphen character. 

4. Click on Insert. 

5. Close the dialog box by clicking on Cancel. 

Copyright © 2010 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft Word 
tips can be found online at http://word.tips.net. 
 



 
Take a good look, 

you just might 

see  yourself. 
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If you have a Web Site  

and would like to advertise it here, 

e-mail me at 
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August 14, 2010 

at the Grayslake Library 

Best Buy of Mundelein will present the latest 

in technology 

Serving Lake County, Illinois 

Since 1983 

Visit us @ http://www.lcace.org 

NEXT NEXT NEXT MEETINGMEETINGMEETING   

Sept. 11, 2010 

Lake County Area Computer Enthusiasts 

409 S. Elmwood Avenue 

Waukegan, IL 60085 
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